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Welcome to the latest edition of my monthly Final Cut Studio newsletter for August, 2008.

The goal of this newsletter is to provide information helpful to the professional user 
of Final Cut Pro. This newsletter publishes each month. Past issues are archived 
at the end of each year with key articles posted on my website for your reference. 
All software references are to Final Cut Studio 2 unless otherwise noted. 

Please invite your friends to visit my website -- www.larryjordan.biz. There you'll 
find daily Final Cut tips, the latest industry news, and over 350 articles and 
tutorials to help you get the most out of Final Cut!
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Welcome!

Well, we are in the middle of summer, but you wouldn't know it for all the activity around here. 
We are gearing up for our fall PowerUP Seminar Tour, more on that in a minute, as well as road 
trips to WEVA, and Final Cut User Groups in Chicago and San Francisco.

It's also been a busy time teaching and creating new training for Lynda.com; plus, Edit Well 
celebrated its third birthday this month!

I also want to say how much I enjoy meeting and talking with you -- whether it is in class, online, 
or during one of our interviews for The BuZZ and Edit Well. I am fascinated by the projects you 
are working on and love hearing your stories and questions, many of which I share with readers 
here.

Finally, I apologize for not getting this newsletter released during July. Like I said, there's a lot 
going on. Which is a perfect segue to what I want to talk about first.

Larry's PowerUP Seminar Tour Starting Sept. 8!

14 cities - 45 seminars - in 60 days. Whew!  
And we start Sept. 8 in Sacramento, CA.

This year, I've created three new seminars based on everyone's comments from last year - and 
the latest news in our industry.

Seminar 1:  
Succeeding in the New World of Tapeless and HD Video

Manufacturers and distribution are moving to HD and tapeless as 
fast as they can pull the tape drives out of new cameras. But this 
new workflow requires us to have a much different technical 
understanding of how this stuff works. This 4-hour seminar 
answers key questions like:

�●     What is the right HD format for my work?
�●     What gear do I need to move to HD?

http://www.lynda.com/
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�●     Where does ProRes fit in?
�●     How can I get better organized?
�●     How do I trouble-shoot my system?

Seminar 2:  
Integrating Adobe Products into a Final Cut Workflow

Every editor I've ever met uses Photoshop, but did you 
know PhotoShop does video editing, too? DVD Studio 
Pro does not support Blu-ray Discs, but Encore does. Final Cut Server can help 
you locate files, but so can Bridge, for a fraction of the cost and much better than 
you might think! I'm not giving up using Final Cut - but there is SO MUCH more I 
can do with Final Cut once I complement it with these Adobe tools. This 4-hour 
seminar shows you how. 

Seminar 3:  
Discover the Hidden Power in Final Cut Studio

The number one request from our seminars last year 
was "show me...". So this 8-hour seminar:

�●     Shows you how to repair poor audio
�●     Shows you how to improve your projects with 

better audio mixing
�●     Shows you how to do a surround sound mix
�●     Shows you how to compress video for DVDs 

better and faster
�●     Shows you how to create Flash videos
�●     Shows you how to transcode HD to SD

In other words, if you want to improve the sound of your projects, or the look of 
your finished video, this seminar is for you.

If you've attended one of my seminars in the past, you know how useful 
these can be. In every session, I leave lots of time for you to get your 
technical questions answered.

If you haven't attended one, you owe it to yourself to come. Our industry is 
changing rapidly and what you don't know can cost you a lot of time and, 
sometimes, a lot of money. I want to help you avoid making mistakes.

I only do one tour a year. It generates the revenue we need to provide these 
free newsletters, tutorials, websites, daily tips and all our other products free 
for your use. So, if you find my resources helpful, please return the favor and 
join us for a seminar or two. You'll be amazed at what you learn.

Our first four cities are:

�●     Sacramento, CA - Sept. 8 & 9
�●     San Diego, CA - Sept. 11 & 12
�●     Dallas, TX - Sept. 15 & 16
�●     San Francisco - Sept. 22 & 23

Click here for more information.

Click here for a list of cities.
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Click here to register. Sign up today and reserve your seat! 

Thanks to our sponsors! 

I am very grateful for the support of our sponsors. Putting on a tour of this 
magnitude takes a lot of hard work and money. This would not be possible without 
the generous support of our platinum sponsor: Adobe Systems; our gold level 
sponsors: Blackmagic Design, Media Distributors, and The Rental Station, 
and our silver level sponsors: Automatic Duck, and Smartsound.

[ Go to Top. ] 

ENTER MEDIA DISTRIBUTORS’ WIN A POWERUP SEAT RAFFLE!

Valued at over $600!   
Media Distributors is proudly offering a chance to attend my PowerUP seminars  

in the tour city of your choice for FREE.  

Visit www.mediadistributors.com to register today! 

Technique: Prepping Still Images for Final Cut Pro

Probably the two most popular questions I get are:

�●     How do I work with HDV
�●     How do I work with still images

A while ago, I wrote an article on how to prep still images for Final Cut Pro which generated a lot 
of response. Recently, two things happened which allowed me to revisit this issue: an effects 
class that I was teaching at Video Symphony and some new training I was recording for Lynda.
com.

During that time, I realized that just as the software has been updated, I needed to update some 
of my recommendations.

First, it is important to note that images on our computer are not the same as images we see in 
video. They differ in color space, color sampling, gray scale, bit depth, and, worst of all, the 
aspect ratio of their respective pixels.

Computers display all images using square pixels. Almost all video displays an image using 
rectangular pixels. And converting between these two aspect ratios is going to drive all of us mad 
-- because it seems that no two video formats use the same shape pixel.

This means that we need to size images on our computer to compensate for these different 
aspect ratios.

Let me illustrate the problem.

Here is a circle in Photoshop.
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Here is a circle in Final Cut Pro 6.x

So far, so good. But, watch what happens when we move that Photoshop circle into Final Cut.



Sigh... it gets squashed. Those poor pixels! On the computer, they are supposed to be square. 
On video, they are supposed to be rectangles. They are having a hard time coping.

You can see this especially well when we superimposed the two circles.



The way to solve this problem is to create our images in Photoshop at a size that allows us to 
see our images correctly on both computer and video screens. 

For instance, when working in 16:9 DV, if we create our image at 853 x 480 x 72, watch what 
happens when we bring it into Final Cut.



It's still a circle! Notice how closely the two circles match -- the red circle was created in Final Cut 
Pro, while the black circle was created in Photoshop. 

BUT...

All is not yet resolved -- a controversy still rages. (Cue dramatic music.)

There is a debate on whether you should bring your Photoshop images directly into Final Cut 
Pro, or if you should, as the last step in processing your image, scale it in Photoshop to a size 
corrected for video and then bring it into Final Cut. 

Based on what I've seen, I have not found any benefit to scaling the final image in Photoshop, In 
fact, my tests show that text looks worse when the image is scaled in Photoshop before bringing 
it into Final Cut. However, it is essential that you do one last scaling of your image if you are 
bringing it into DVD Studio Pro. (This finally explains a problem I had two years ago that cost me 
a client.) 

In fact, scaling your final image in Photoshop from, say, 720 x 540 to 720 x 480 in Photoshop just 
prior to importing into Final Cut Pro makes the text look worse. 



Note: This article just covers single-layer TIFF, PNG, or JPEG images. I'm still 
working on multi-layer PSD files. I haven't found any numbers that I like well 
enough to recommend so far; the image scaling, especially in 16:9, is a complete 
mess.

HERE ARE THE WORKFLOWS 

Moving Singe-layer Still Images into Final Cut Pro

�●     Images can be TIF, PNG, or JPEG; however, I prefer TIFF.
�●     Create / size your image in Photoshop according to the size table below.
�●     Import the file into Final Cut using File > Import > File.

This process works for both 4:3 and 16:9 images.

Final Cut will scale the image into the correct aspect ratio for video automatically. 

Moving Singe-layer Still Images into DVD Studio Pro

You need to do this whenever you are creating a DVD SP menu background in Photoshop.

�●     Create your image in Photoshop according to the size table below.
�●     When the image is complete, save a master copy
�●     Go to Image > Image size and turn off Constrain Proportions
�●     Change the image size to 720 x 480 x 72
�●     Save a copy of your image.
�●     Import the scaled copy into DVD Studio Pro and use it as your menu background. 

This process will materially improve the look of your text on screen.

Note on images for HD Video

Regardless of what HD video format you are using, always create your still images 
at one of two sizes. Final Cut will handle all scaling properly. While I haven't 
checked this for all possible formats, I have found this works perfectly for both 
HDV and DVCPRO HD.

Note for creating images you want to do moves with

For those images that you want to do moves on in Final Cut, multiply each 
dimension by 2.5 and size your image in Photoshop to match. Remember, the 
highest quality for any image is when it is sized to 100% or smaller in Final Cut 
Pro. So, use Photoshop to do image scaling - it will look much better.

Note on pixel dpi



In video it is the total NUMBER of pixels across, by the total NUMBER of pixels 
down. DPI is not relevant for video, just for printing. For this reason, we 
traditionally say that video is 72 dpi. It isn't, really, but since it is the number of 
pixels we care about, not their density, we arbitrarily set the DPI setting to 72.

Note on computer monitors

A problem I ran into recently was using a third-party (non-Apple) monitor with Final 
Cut Pro. This particular compuer monitor, from a name brand company, used 
rectangular pixels to achieve full resolution. This meant that even when you looked 
at a circle created inside Final Cut Pro, it looked squished. Sheesh! Make sure 
your monitors display circles accurately - a test is ideal, but, at least see if they 
use square pixels to display their images. 

IMAGE SIZE TABLE 

VIDEO FORMAT IMAGE SIZE NOTE
NTSC DV 4:3 720 x 540 x 72  

NTSC DV 16:9 853 x 480 x 72  

   

NTSC SD 4:3 720 x 486 x 72  

NTSC SD 16:9 853 x 486 x 72  

   

PAL DV 4:3 768 x 576 x 72 From Apple's FCP manual

PAL DV 16:9 1024 x 576 x 72 From Apple's FCP manual

   

NTSC DVD SP 4:3 720 x 534 x 72 Scale to 720 x 480 in Photoshop

NTSC DVD SP 16:9 853 x 480 x 72 Scale to 720 x 480 in Photoshop

Whew.

Apple's manual says this can be confusing to beginning editors. From my point of view, it's 
confusing to pretty much everybody. I hope this explanation helps. 

UPDATE - Aug. 16, 2008

I did some further testing. In an earlier version of this newsletter, I recommended an image size 
of 864 x 480 for 16:9 DV because it provided a more accurate circle. However, it does not 
completely fill the frame. So, I've gone back to recommending the image sizes in this table as the 
best combination of full-frame image with accurate geometry. 

[ Go to Top. ] 

Status of Larry's Videos on GIMP.TV

John Stealey wrote me recently saying:

My iTunes tells me the links for Buzz video is bad - I clicked on the "website" 



option and no link - has it moved?

Larry replies: Um, no. Its disappeared -- for a while. 

The Digital Production BuZZ videos were distributed by GIMP.tv. About a month ago, they called 
me saying they were taking their servers down for an upgrade. Then, they never came back up.

Just last night I learned that they had a problem with funding which required them to suspend 
their site for a while. They tell me they expect to get things up and running shortly. 

Hopefully, we'll have a solution in a couple of weeks that I can announce in the next newsletter.

[ Go to Top. ] 

Digital Production BuZZ is Traveling to Chicago FCP Users Group!

Yep! August 27, I'll be speaking at the Chicago Final Cut Pro User Group and, we'll be doing a 
"live-on-tape" BuZZ Podcast right from the meeting. This will feature our usual mix of great 
guests, plus live "Pick Our Brains" questions from the audience.

I'm really excited because this is the first time I've taken The BuZZ on the road and I'm looking 
forward to meeting everyone in Chicago!

Click here to learn more about The BuZZ.

Click here to learn more about the CHIFCPUG meeting.
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Digital Production BuZZ Official Podcast of DV Expo  
AND Government Expo!

The folks at New Bay Media have asked us to be the Official Media Partner of DV Expo - Nov. 
4-6 at the Los Angeles Convention Center.

 

DV EXPO 

If you are a videographer, cinematographer, director, producer, camera operator, 
editor, post supervisor, sound editor, motion graphics designer, web video 
producer, corporate video producer or documentary filmmaker ... THIS IS YOUR 
EVENT!

More than 45 conference sessions and top industry exhibits showcasing hundreds 

http://www.chifcpug.org/
http://www.digitalproductionbuzz.com/
http://www.digitalproductionbuzz.com/
http://www.chifcpug.org/
http://www.dvexpo.com/


of new products await you and your questions. These three days will be packed 
with education and information you won't get anywhere else! 

No sooner did we say yes to covering DV Expo, than New Bay Media came right back and asked 
us to be the official Media Partner for Government Expo - Dec. 2-4 at the Walter E Washington 
Convention Center in Washington, DC.

GOVERNMENT VIDEO EXPO 

Government Video Technology Expo reflects the diversity of the government video 
market, including state and local government, law enforcement and federal 
agencies. And of course our men and women in uniform. GV Expo delivers an 
exhibit hall with more than 200 vendors, certification and training classes in post-
production and a wide reaching Government Video conference program covering 
issues in video, audio, multimedia, conferencing and broadcast. This is a one-of-a-
kind event designed to bring government buyers and sellers together. Register 
today. 

We'll be originating two hours of live coverage every day of the three day event. 

We'll have more on this as we get closer. But, if you can free up a day in your calendar, come on 
over to the show and say "Hi!" We'd love to see you.

Click here for DV Expo.

Click here for Government Video Expo.

Click here to learn more about The BuZZ.
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Chroma-keying using Motion and Final Cut Pro

Recently, I went looking in the Editing Library on my website for an article on chroma-keying, 
only to discover that I have never written on the subject. 

Since the keyer in Motion can do some really nice work, I figured it was about time I wrote about 
how to use it, so here it is.

GETTING STARTED

While you can do the entire key in Motion, that would mean that you need to really understand 
the Motion interface and its tools. For some, that's easy, for many others, Motion remains an 
unknown application.

So, in this exercise, I set myself the goal of showing how to create a great looking key using the 
combined features in Final Cut Pro and Motion that only requires learning one new keyboard 

http://www.gvexpo.com/
http://www.dvexpo.com/
http://www.gvexpo.com/
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shortcut and one dialog panel. And the results look really nice.

For this tutorial, I'm using some footage of me that I shot for my video podcasts. This was shot in 
DVCPROHD 720p60 and 720p24, using a rented HVX-200 camera. 

Important note: If you plan to do a lot of green screen work, DON'T shoot in 24 
fps. The motion blur it causes is significant and makes keys much tougher to do 
well. Shoot at a higher frame rate, do your keys, then convert the resulting video 
down to 24 fps for final output. Here's a recent article on shooting 24 fps. 

SETTING UP THE KEY IN FINAL CUT PRO 

Let's get started: Build your key in Final Cut Pro. Put your background image on V1 and your 
green/blue screen image on V2. (In this example, I'm using green screen material - however, the 
procedure is the same for blue-screen as well.)

As we will do the final composite in Final Cut, all we need to send to Motion is the top clip. We'll 
use Motion to remove the green background and make it transparent.

Select the V2 clip and go to File > Send to > Motion project. In the dialog that follows, give your 
key a name, and store the file in your FCP Projects folder, along with the other elements you are 
using for this project. This file will become a permanent part of this project.

http://www.larryjordan.biz/articles/lj_range_war.html


(In my case, since I only need this file to write this tutorial, I'm storing it to my Desktop to make it 
easy to erase.)

Once you click OK, Motion starts up and your V2 clip appears in it automatically.

CHROMA-KEYING IN MOTION 

Once your clip appears in Motion, select the clip by clicking it once. (Just as in Final Cut, the key 
interface rule for Motion is to "Select something, and do something to it.")

A thin white bounding box appears around the edges of your clip. This tells you that it is selected.

Go to the Toolbar at the top and click the Add Filter button. From the pop-up menu, select 
Keying > Primatte RT. This applies the filter to your selected clip.

Everything will look worse. DON'T PANIC.

Once you apply the filter, the floating gray palette called the HUD should display with a variety of 
controls in it. If it doesn't press F7. If there's nothing in the HUD, be sure the clip is selected the 
clip and reapply the filter.

With your clip selected, and the Primatte RT controls visible in the HUD, make the following 
changes:

* Click the Green Auto Sample button if your background is green, or the Blue Auto Sample 
button if your background is blue.



* Set the Output Type pop-up menu to Matte.

Slide the Noise Removal slider all the way to the left.

Adjust the Matte Density slider until the foreground is solid white. The background will go hazy, 
or show white dust. This is normal, all you are looking at in this step is to make the foreground 
opaque.

Adjust the Noise Removal slider so the background is solid black. Its setting will always be less 
than the Matte Density slider.

Switch the Output Type pop-up back to Processed Foreground.



  
  
  
  
  
  
  
  
  
  

Adjust the Spill Suppression slider until the image color looks normal. (You can color-correct 
this in Final Cut if you need more control.)

Save your work in Motion and switch back to Final Cut Pro.

Final Cut will automatically update the sequence with the newly-keyed clip from Motion and, 
poof! You have a great looking chroma key.



DEALING WITH ROUGH EDGES 

Sometimes you'll end up with heavy stair-stepping around the edge of a foreground object. The 
best way to fix this is to:

�●     Switch the Output type menu back to Matte
�●     Slide the Noise Removal slider all the way to the left
�●     Slide the Matte density slider to the middle of the scale
�●     Control-click the green color chip in the top third of the HUD and manually adjust the 

green selection by dragging the pointer until the matte is solid white. Again, remember 
that the background will go gray/hazy, this is normal.  
 

 
 

�●     Adjust the Noise Removal slider until the background is solid black. This may take a bit of 
tweaking beween these settings to look right.

The nice part about this procedure is that it is fast and works great -- without having to learn a lot 
about Motion. And, I've found, I get better keys this way than in Final Cut Pro by itself.



UPDATE - Aug. 16, 2008

As an additional note, you can also clean up rough edges by applying the Matte Magic filter in 
Motion to smooth out the edges of your key. Gently adjust Shrink or Feathering until your edges 
look better. 

[ Go to Top. ] 

Thoughts on Improving Green Screen Results

Ed Yost started me thinking about green screens in an email he wrote me a few months ago. 
Based on his comments, I began researching the topic and just finished recording an entire title 
on working with green screens in Final Cut Studio for Lynda.com. 

It should be out around the beginning of September or so.

As I was working on the title, I learned several things that I want to share with you.

Not all keyers work the same

The chroma-keyer in Final Cut Pro hasn't been updated since at least version 3. It 
was OK then, it is quite often not adequate now. If you can get an acceptable key, 
please use it. If not, you have options, some free and some not.

The best chroma-keyer in Motion is the Primatte RT filter. 

The best way to create an effect is to build the effect in Final Cut Pro, then send 
the green screen clip to Motion for keying. 

There are a number of really good chroma-keyers that you can buy that work with both Motion 
and Final Cut. For the Lynda.com training, I tested three:

�●     VKey 2, from Oak Street Software
�●     DV Matte Blast and DV Matte Pro, from dvGarage
�●     Primatte Keyer Pro 4, from Red Giant Software

VKey is inexpensive, about $50, and often does better keys than the Primatte RT keyer shipped 
with Motion. But, its interface is awkward and takes tweaking to get a good key with mediocre 
material.

dvMatte Blast/Pro creates a great key very quickly, but it does not handle shadows well and it 
has a real problem in HD when you try to use it with a matte to get rid of garbage in the frame. 
However, when you don't need mattes or to project shadows on your inserted background, it's a 
great choice.

Primatte Keyer RT is the most expensive of the three, but it does a better job of keying hair and 
projecting shadows than the others. (By projecting shadows I mean that the shadows cast by a 
foreground object on a green/blue screen can be transfered so that they are cast on the new 
background (say a brick wall) in the key. It is a very cool effect.)

I'll have training on how all these keyers work in my upcoming Lynda.com videos.

http://www.oakstreetsoftware.com/gkey/
http://www.dvgarage.com/
http://www.redgiantsoftware.com/products/categories/keying/primatte-keyer-pro/
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Edit Well Celebrates Its Third Birthday!

August marks the third birthday for Edit 
Well - the rich-media magazine for Final 
Cut Studio, which I edit for Peachpit 
Press.

Publishing anything for three years is an 
accomplishment and this month's issue 
has articles from some of our favorite 
authors. 

Click here to see the Table of Contents (646 KB) .

However, this month, I want to thank the key person behind the scenes who has made Edit Well 
possible. As I wrote in my column in that issue:

I created the first issue of Edit Well almost four years ago, hoping that it would 
become a part of the Final Cut community, but it wasn’t until Peachpit Press 
agreed to join us that Edit Well became a reality. For this, I owe a tremendous 
debt of gratitude to Nancy Aldrich-Ruenzel, publisher of Peachpit Press. Without 
her interest, Edit Well would not exist. Without her support, it would not continue. 

Thank you, Nancy and Peachpit Press!

If you haven't subscribed yet, please do so - you won't find a better publication covering Final Cut 
Studio anywhere else on the planet.

Click here to learn more about Edit Well. 
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Heads-Up - New Video Format

Panasonic has released a new camera and a new video format - AVCCAM. This brings to three 
the number of AVC (H.264) video formats: AVCHD, AVC-Intra, and AVCCAM. They are not the 
same. Be sure to check to see if Final Cut supports your camera and this video format before 
purchasing.

Click here for a list of supported devices in Final Cut Studio. 
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Heads-Up - FxPlug Problems

http://www.peachpit.com/editwell
http://www.peachpit.com/editwell
http://www.peachpit.com/editwell
http://www.peachpit.com/editwell
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Just a note based on what I'm reading on the web.

FxPlug plug-ins from Apple and others won't render with multiple graphics cards installed in your 
MacPro system.
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Philip Hodgetts Has a Book on HD

Philip Hodgetts, one of the few people that could live with naming his company "Big Brains for 
Rent" has self-published a book called "The HD Survival Handbook."

This 212 page book was written to answer "the myriad of questions that arise when a video 
professional moves from SD into HD."

I've been reading thru my copy for a while now and it is excellent.

Take a look for yourself here. 
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MXF Data Now Available for Final Cut Studio

Bjorn Adamski sent me a note about a product he helped develop: MXF4QT.

MXF for QuickTime: The most integrated and universal MXF solution available. 
MXF4QT integrates seamlessly into the QuickTime multimedia architecture 
making MXF accessible in any Mac OS X application. MXF4QT is a pure desktop 
video client based software solution to plug in MXF compatibility into your entire 
Mac system.

MXF files are used in DVCPRO HD video formats, among others. 

For more information, click here: http://mxf4mac.com/products/

UPDATE - Aug. 12, 2008 

Willard Jansen sent in the following:

I have purchased MXF components from MXF4MAC and I have used them now 
on 4 projects using and Xserve with osx leopard server, two quads and one 
macpro. All running FC Studio 2 and Final Cut Server (edit-in-place connected to a 
SAN).

First 
this solved the problem of having anamophic 16:9 media clip-poster frames and 
and clip proxies in Final Cut server being 4:3. This is because the MXF4MAC 
component has the quicktime aperture setting set to clean, whereas the Sony 
Transfer Tool outputted file doesn't.

http://www.proappstips.com/HDSurvivalHandbook/
http://mxf4mac.com/products/


Second 
I can Copy the clips from the XDCam disk to the designated media folder which is 
about twice as fast as trasfering them with the Sony tool.

Third 
Rendering seems much faster (I have tested a 20 clip, with a motion master 
template with a graphic credit titles that is superimposed over a third of the video 
clip. Rendering in this test on a Quad was about two times as fast.

Problem 
Initially I got all sorts of problems while copying files from the XDCam disks The 
the raid, on all systems (XDCam uncounts, not being able to eject it, and copy 
errors because the finder was not able to read or write files). These problems went 
away after de-installing the component and again occurred after re-installing it.

I reported this to Björn Adamski and together with a lot of testing we found a 
workaround. When examening the concole logfiles we saw that the finder crashes 
on a timeout while trying to make clip previews. The workaround comes down to 
disable icon preview in the finder for all views (column, Icon etc). I set this to 
default and restarted the system. Now everything works great.

Later I spoke to an certified maintenance engineer and he told me that he had 
seen the same problem with HDR files on Leopard. 

All in All the component works great for me with icon preview turned off.

Larry replies: Willard, thanks for the update. 

[ Go to Top. ] 

Entry-Level Color Grading

Frank Jonen sent this in:

Here's a real beginner's tool for grading in FCP: http://www.dvshade.com/
Welcome.html

I just found this and maybe it's useful for some editors to previz a look during the 
edit. To check if a mood emphasis can save a shot from the bin or not. And for 
that price it seems to be a cool thing to have on your belt.

Seems less confusing than Color, at a similar price-point ;)

Larry replies: Thanks!

[ Go to Top. ] 

Understanding ProRes 422

Jonathan Kirsch writes:

http://www.dvshade.com/Welcome.html
http://www.dvshade.com/Welcome.html


I don't work in HD (yet) so I'm not that familiar with it, but reading EditWell and 
your newsletter has got me thinking. I've read instances where people say they 
shoot uncompressed HD and bring it in to FCP as ProRes to edit in, then export it 
as uncompressed HD. How is that possible? Am I remembering what I read 
correctly? 

Isn't ProRes a form of H.264, which is lower quality than uncompressed HD? If so, 
once you capture in a low quality, how to you export to high quality? 

My first guess is by recapturing everything in the uncompressed HD. Isn't that a 
waste of time? It seems so many people who shoot, for example, HDV, edit in 
ProRes. Well, isn't that a lower quality than the HDV? What am I not 
understanding? 

Larry replies: Jonathan, these are great questions. There's a lot of confusion about ProRes out 
there.

First, ProRes is NOT a form of H-264. It is a new codec, developed by Apple, that provides high-
quality, frame-accurate editing. H.264 is a distribution codec for finished work. ProRes is an 
editing codec to provide very high-quallty images without taking a lot of storage space. 

Apple, and others, describe ProRes as visually loss-less. That means that while data is being 
removed during compression, the resulting images do not suffer from image degradation. Based 
on what I've seen, images which have been converted to ProRes and copied 10 generations 
show virtually no loss in image quality. Unlike, say, images copied in JPEG or HDV for 10-
generations.

Uncompressed HD can requires up to 250 MB per second -- far exceeding the ability of a single 
hard drive to support. ProRes needs less than 30 MB per second. While this is more than a 
single drive FireWire 400 or even 800 can comfortably support, this is well within the range of 
even inexpensive RAIDs.

Here's a quick comparison between HDV and ProRes:

HDV ProRes 422 Notes
8-bit depth 10-bit depth 10-bit is better 

GOP-compressed I-frame compressed I-frame is better and 
much faster 

Rectangular pixels Square pixels 
Don't need to 
convert pixel aspect 
ratios 

Needs conforming 
before output 

Doesn't need 
conforming 

Not conforming is 
better 

4:2:0 chroma-
subsampling 

4:2:2 chroma-
subsampling 

4:2:2 makes for 
better chroma-keys 
and color correction 

The currently accepted HDV workflow for professional-grade work in FCP is to shoot in whatever 
HDV format you want then transcode into ProRes during capture, or as soon thereafter as 
possible. (This works for other HD formats as well, but as Andy Mees notes below, this may not 
be the best way to work.) 

Edit your sequence in ProRes, then output to D5 or HDCAM for distribution. The output would 
require a capture card from Blackmagic Design or AJA to convert the ProRes into a release 
format.

http://www.peachpit.com/editwell


If you are going to the web, editing native HDV is fine, though much slower. If you are planning 
on projecting your images to a large screen, keep in mind that HDV often has problems with 
images, or camera shots, that are moving quickly. Shooting in a different video format might be a 
wiser choice.

UPDATE - Aug. 12

Andy Mees sent in the following:

As a professional working, often exclusively, with the XDCAM HD format, I would 
say that transcoding to ProRes during capture (or as soon thereafter as possible) 
gains me absolutely nothing but larger files! I have two semingly far better options 
available to me:

1) Edit in a native sequence w/ renders set to ProRes ... finally, Export > 
Quicktime Movie to a ProRes master

2) Edit with my native footage directly in a ProRes sequence ... finally Export > 
Quicktime Movie as Self Contained With option 1) I get superb native timeline 
performance (preview quality performance with any graphics or other footage that 
may have been created natively in ProRes) and superb render performance 
regardless. At the end of the day I can export my edit as ProRes, Uncompressed, 
or whatever I need, transcoding only the parts of the footage I need. With option 2) 
I get preview quality timeline performance (and of course, native speed and quality 
w/ any native footage), superb render performance regardless ... and again, at the 
end of the day I can export my edit in whatever I need.

Obviously what works for me won't be everyone's cup of tea, but the "accepted 
wisdom" is trotted out so often, and in so many places, and by very highly 
respected and influential folks (such as your good self) that once in a while I do 
wish someone would stand up and question it. I'm absolutely not trying to be 
argumentative for argument's sake here. If you have time, and I do mean this 
sincerely, I would love to hear why and how I would profit by transcoding all my 
footage to ProRes before I begin to edit. 

Larry replies: Andy, these are great comments. I agree, using ProRes for your render files is a 
much better way to work. (To do so, go to Sequence > Settings > Render control tab and 
change the codec to ProRes.) 

However, I don't advise exporting using File > Export > QuickTime conversion. First, it is too 
slow. Second, it always downsamples your video to 8-bit, removing a lot of the quality you put in 
by using ProRes in the first place. Third, because Compressor does a much better job much 
more quickly.

If you are working in a single video format, capturing natively and setting render files to ProRes is 
an excellent workflow.

If you are working with multiple video formats, from my point of view, transcoding them all into 
the same ProRes format will decrease your integration headaches. 

If you need to convert from one format to another, Compressor will always do a better job than 
QuickTime conversion, except when creating WMV or FLV files, which Compressor does not 
support. QuickTime Conversion can do this, provided you install the correct plugins. 

UPDATE - Aug. 16



Senad Grahovic sent in the following:

I have followed the discussion about creating FLV files on your Blog and I believe 
there is a solution since flash player 9 supports H264 codec natively.

The trick is: packing mov files into a mp4 container with quicktime pro and rename 
the extension to .FLV

Both audio and video should use mpeg4 ISO-Standard Profile.

If packing to mp4, use "passthrough" option for both Audio and Video.

If you have several files to rename, there are a bunch of batch-rename apps for 
windows and mac - there, you can even use Automator.

So i think there is no expensive compression software necessary ;) Remember, 
this works for Flash Player 9.

Larry replies:Thanks!

[ Go to Top. ] 

Storing Files During Round-tripping

Rob Shaver, from Austin, Texas, writes:

How do I control where FCP/STP puts the modified audio when "round-tripping" 
the audio?

Larry replies: Rob, you determine where files are stored when the Send to dialog comes up. For 
instance, in the image below, 

 

This is the top of the Send to dialog for both Soundtrack Pro and Motion. You enter the file name 
and location for the file you are creating, In general, I recommend storing these files in your Final 
Cut projects folder, the same folder you use to save your FCP and Motion projects. That way, 
you know where they are and you can easily back them up with the rest of your project files.

[ Go to Top. ] 



Counting Words for Voice-Over Timing

Gregory Ikens sent this to Philip Hodgetts who sent it to me:

The following word count timings should assist you in determining how many 
words will comfortably fit within a specified amount of time in a spot. This guide 
assumes a “normal” rate of speech (neither fast nor slow) and a basic “announcer” 
read. 

Please note that for phone numbers, each spoken number = 1 word. 
(i.e., 1-877-000-0000 = 11 words)

WORD COUNT TIMINGS 

WORDS SECONDS
7 words 3 seconds

12 words 5 seconds

17 words 7 seconds

23 words 10 seconds

35 words 15 seconds

70 words 30 seconds

140 words 60 seconds

Larry replies: I love trivia like this. Thanks!

 
[ Go to Top. ] 

More Thoughts on Creating Good Voice Over Recordings

Ben Balser sent in his thoughts on my recent article on the voice-over tool:

I'd like to add to the Voice Over discussion. The single best investment you can 
make to achieve great VO quality recordings is a "real" studio quality microphone. 

I encounter so many videographers who use "OK" mics, get "OK" quality, and 
think it's "great" quality, which it isn't. Most video editors are just that, "video" 
editors, not sound engineers. A really good quality mic will make a world of 
difference. I personally use the Sennheiser e865 for studio use, and the e835 for 
hand held field use. Any mic of this quality will give you so much more for your 
sound dollar. 

The other two pieces of hardware I absolutely love, which give me much better VO 
work is a pop filter (comes on a flexible goose neck mount), and the sE Electronics 
Reflexion Filter. The Reflexion is pricey, and pretty high tech for sound work, but it 
gives me drastically improved sound both in the studio and in the field. Many 
recording studios and famous musicians use this, even inside the sound controlled 
recording studio. If you have the bucks, the Reflexion is very worth the money for 
"serious" voice recording. 

http://www.seelectronics.com/rf.html
http://www.seelectronics.com/rf.html


But the mic and pop filter are the two best investments, beside education. I hear 
so many voice recordings by videographers that are too bass heavy, too thing, just 
plain off, when a tiny bit of sound education would make drastic improvements. 
Learn sound from sound engineers, learn video from video engineers, that's my 
firm belief. But then, I was working in audio recording studios as a semi-pro 
composer for many years before I ever got into video work.

Larry replies: Thanks, Ben, for the feedback.

[ Go to Top. ] 

Reader Mail

We seem to have lots of problems this month.

[ Go to Top. ] 

FONT PROBLEMS IN MOTION 

Eric Hoffhines writes:

I'm working in FCP Studio 2 -- DV NTSC Anamorphic. When I create text in 
Motion, it is much smaller after I round trip back to Final Cut. What settings do I 
use in Motion?

Larry replies: I've heard about this problem for a while. But this time, I decided to figure out what 
the problem is.

The top line of each pair, with the period, is from Motion. The bottom line is from Final Cut. All 
font settings match in the two applications. 

Come to find out, Motion and Final Cut calculate the font SIZE the same, but they don't calculate 



font TRACKING the same. 

To match fonts between teh applications, create a text clip in Final Cut with the font you want to 
use and set the tracking to 1.8 in the Controls tab of Final Cut Pro. They won't match perfectly, 
but they will match pretty darn close. So close, that if I took a screen shot at 50% scale, you 
would not see a difference.

[ Go to Top. ] 

VIDEO CHANGING BRIGHTNESS DURING COMPRESSION 

Jeffrey A. writes:

Working with DVCPro HD footage -- which looks great on set on the field monitor, 
and looks the same within FCP 6 (both in the canvas window and full screen 23" 
cinema display) -- but is very bright/washed out when burnt to DVD via 
Compressor 3 and DVD Pro 4.

This is when watching the DVD's on various TV's, from old CRT's to new high end 
sets.

This is not a new problem for me. Exact same issue from the day I bought my dual 
2.0 G5 -- using FCP 4 and 5 with DV footage -- and burning DVD's by making QT 
Ref movies imported into iDVD.

Only solution has been to ridiculously darken my FCP sequence for DVD burning 
purposes.

Any idea what's going on here?

Larry replies: Nope, but some readers have. 

UPDATE - Aug. 15, 2008

Bill Groody has also noticed this problem and sent in the following:

I have had this problem with SD video for years. My solution was to set up a 
special setting in Compressor to deal with the situation.

After comparing on my outboard monitor and scope, the output of color bars from 
Final Cut with the same bars compressed and burned on a DVD and played on a 
commercial DVD player, I settled on adjusting the gamma to 1.1 in Compressor 



when using my tower. Previously, I used 1.2 on my G-4 Quicksilver. The DVD's 
look great every time. 

Larry replies: Thanks, I'll add this to my notes. 

[ Go to Top. ] 

NOT FEELING THE LOVE 

Jason Whinnery writes:

I'm feeling like a total idiot right now. I have a Canon HF100 AVCHD camcorder 
that has a setting for 30P. No matter what I do in FCP, the files get ingested as 
interlaced. I don't care so much about the 24P setting (although I tried a test 
resulting in an extreme headache) I just want to make 30P work. What am I doing 
wrong?

Larry replies: Well, um, you are not doing anything wrong, but you managed to pick a camera 
that is not supported by Final Cut Studio.

I get this problem a lot. So, keep in mind that just because a camera is shipping does not mean 
Final Cut supports it. Camera manufacturers want to sell cameras. Whether they work with FCP 
is ALWAYS a secondary consideration.

UPDATE - Aug. 12

Adam Lloyd Connell writes:

I went to a technology training night with Canon recently, and borrowed one [of 
these cameras] from a store to play around with and figure out how the HF10/100 
worked. The acual files that the HF10/100 cameras are recording to their internal 
memory is interlaced. Same as the Hv20/30. they boast Progressive frame 
sensors, but the files are compressed as interlaced, for software compatibility for 
home users. The end result is virtually a de-interlaced file. Therefore, although 
there are not any interlace lines to be seen in the final image, FCP will still report 
the file as being a 1080/50i or 60i file after you import the file into FCP 6 (can be 
done) with the File> Log and Transfer process.

Larry replies: Thanks for the update.

To find out what cameras are supported in what version, visit this website: http://www.apple.com/
finalcutstudio/resources/

[ Go to Top. ] 

AUDIO CONUNDRUM 

Peter Koeleman, from Minneapolis, sent this in:

The problem we are having is that you can't hear the audio on the even tracks 

http://www.apple.com/finalcutstudio/resources/
http://www.apple.com/finalcutstudio/resources/


(2,4,6, etc.). It does this regardless of the camera we use. We consulted with an 
Apple genius desk and their solution was to uninstall and reinstall FCP. Fairly 
logical. We went a step further and re-imaged the hard drive and then reinstalled 
FCP. Same problem.

Larry replies: Before I even finished reading this, Peter sent in the answer he discovered.

Peter writes:

Actually after a day of pulling hair out and using the Apple forum, we figured out.

It was simply a setting: Sequence>Setting>Audio Settings>set to Stereo.

Voila! It worked.

Larry replies: Thanks! I'll share with everyone else to save the remaining hair on editor's heads 
the world over.

[ Go to Top. ] 

H2 RECORDER REVIEW COMMENTS 

Neil Klemek, from Berea, KY, sent in the following comments on my Samson H2 recorder 
review:

I read your review of the Zoom H2 audio recorder in a recent issue of your monthly 
newsletter. I wanted to ask you if you did not inadvertently "compare apples with 
oranges". With the H2, you used their internal mics and with the Marantz you used 
a Shure SM-58, rather than the Marantz's own internal mics. How did the H2 
compare and the Marantz subtracting the SM-58 from the picture? The SM-58 is a 
UNI-directional mic, which would naturally do better in a noisy room, while the 
internal mics of the H2 and Marantz may be OMNI-directional. What do you think?

Larry replies: This is a good and fair question.

Comparing the mikes I used with the Marantz WOULD make it an unfair comparison. Essentially, 
the Marantz with external mikes would be the same as the H4 with external mikes. The H2 does 
not support external mikes, something I knew when I took the unit for review. The Marantz has 
no mikes at all - it is simply a digital recorder.

What surprised me about the H2 was the extreme low levels and poor audio recording quality - 
even allowing for using the built-in mikes. It is marketed as a device where speed, ease-of-use, 
portability, and quality are important. I found it exceptional in all these categories - except quality. 

[ Go to Top. ] 

MISSING AUDIO

John Thomas writes:

http://www.larryjordan.biz/articles/LJ_review_zoom_H2.html


I just captured a project and found an anomaly in the audio. All my audio tracks 
are mono 1a. When I looked up item properties they show tracks 1V, 1A. When I 
went to my log and capture audio is set to 2 channels. Any ideas where I went 
wrong? Do I have to recapture all the media?

Larry replies: John, in the Log and Capture window, in the Clip Settings tab, you have the ability 
to turn off the capture of an audio track by clicking one of the green visibility lights.

Since FCP always captures 2 tracks, even if one track is empty, that would be the first place to 
look.

[ Go to Top. ] 

EXPORTING MULTIPLE TRACKS OF AUDIO 

Peter Tours writes:

I need to do an output to DigiBeta with 4-channel audio. However, I need to create 
the file at home, but output it at work.

Here's the question: can I do a 4 channel export to QT or do I have to export 3&4 
to aiff and sync them in the new timeline @ the studio? Sequence is DVCPRO-50.

Larry replies: Piece of cake. Here's the article that explains what you need to do.

http://www.larryjordan.biz/articles/lj_mult_audio.html

[ Go to Top. ] 

TEXT FLICKERING 

Keith Thompson, of Free Street Productions, writes:

I'm at finishing up a project and have one last problem. The project was shot 
720p24 in HDV and I've placed scrolling credits at the end, scrolling up from the 
bottom. The problem is, no matter what my setting, the text flickers and is blurry as 
it scrolls. I've tried the De-interlace filter, the flicker filter, both together and 
separately. Building the scroll in Live Type or in FCP using Boris also produces 
the same result.

Is there a fix for this? I'm getting desperate. This thing has to go to the DVD 
duplicator this week.

Larry replies: Keith, you may have shot it in 720p24, but if you are producing it for a DVD, you 
have down converted it to standard-definition video and all SD video is interlaced.

So, the compression software added interlacing to your video during compression. At which 
point, things get really complex.

There are only a few speeds that allow text to scroll smoothly with no interlace artifacts and none 

http://www.larryjordan.biz/articles/lj_mult_audio.html


of the applications in Final Cut Studio allow you to set the roll speed to avoid these artifacts.

If you need clean titles, the best thing to do is to avoid the roll and put up each screen as a 
stationery text clip.

[ Go to Top. ] 

ADDING INTERLACING TO PAL FOOTAGE 

Keith wants to remove interlacing, but Matt Davis wants to add it:

You may remember a while back I was asking about how to re-interlace 720p50 to 
PAL 50i?

It turns out that Compressor CAN do this all along, and big shout to Ripple 
Training's Compressor 3 series.

It's somewhat unintuitive considering Apple's reputation in User Interface Design, 
but not exactly unique when considering their Pro Apps.

Import your 720p50 movie into compressor, Open up Advanced Format 
Conversions --> Standard Definition --> DV PAL Anamorphic and apply this 
template. 

Whilst selected, click the Inspector window --> Frame Controls tab, uncheck the 
'Auto Everything' gear wheel, switch Frame Controls ON, set output fields to 
Bottom First and don't touch Deinterlace (which was phasing me so much I never 
even tried the above until watching Ripple's movies).

Lo and behold, interlaced DV output from EX1's 720p50.

I'm still doing tests and intend to publish a few movies, but Compressor does it 
again, despite its contradictory and confusing interface.

Larry replies: Thanks for the update and, yes, the guys at Ripple Training do good work.

[ Go to Top. ] 

DIFFERENT FRAME RATES - DIFFERENT FRAME SIZES - ONE TIMELINE 

Craig Olmstead writes:

I'm currently working on a project where we shot some footage on Sony's EX1 
camera in the XDCAM format on SXS formated drives and we also shot some SD 
footage as well as incorporating some analog footage from Beta SP....

I've split the project up into various sequences to make it easier with organization 
of produced sections....

My question is on final play out to record I plan on using MOTU V3HD hoping to 

http://www.rippletraining.com/


make final sequence with the settings set to the final format that our client is 
wanting which is SD. I will be recording onto a DVCPro VTR and concerned that I 
may have issues in doing this since there are multiple formats at different frame 
rates on one timeline.

Larry replies: Sigh... There's no easy way to do this. You can only have one frame size and one 
frame rate on a video tape. So, you'll need to output all these sequences, then run them through 
Compressor to conform them to the same frame size and rate.

Then, create a new sequence that matches the output formatted supported by your deck, import 
and edit these movies into this new sequence and output to tape.

Basically, your tape deck will determine the final format of your project.

[ Go to Top. ] 

THE LAST QUESTION 

Alex Kogan writes:

I have a video with Chapter Markers on the Timeline & in the Canvas. 
 
I need to cut out a couple of seconds from the middle. So I use the blade tool, 
make 2 cuts, then select the empty space, and press backspace. The second part 
of the video moves, but the markers stay. How do I make the markers move 
together with the video?

Larry replies: You can't. However, there's a workaround.

UPDATE - Aug. 12

David Welch and Robert Gobeille both sent in the following:

The way I've worked around this in the past is to put a marker on the clip in the 
timeline so when you cut out a chunk of video that marker will follow.  Then you 
can move the marker on the sequence to match the new location... not elegant, 
but it works.

[ Go to Top. ] 

WRAP-UP

Well, that's about it for this month. 

For current news on what's happening in our industry, be sure to listen to the Digital Production 
BuZZ podcast every week.

�●     Register now for our PowerUP seminar tour. 
�●     Visit our store for our latest training videos - like HD Workflows in Final Cut Pro. 

http://www.digitalproductionbuzz.com/LiveThisWeek
http://www.digitalproductionbuzz.com/LiveThisWeek
http://www.larryjordan.biz/sem/2008_fall.html
http://www.larryjordan.biz/app_bin/Store/catalog/


In the meantime, please continue sending me your comments and questions. I love hearing from 
you and enjoy the conversations that develop around these stories.

Until next month, take care, and edit well.

Larry

Subscribe to Larry's FREE

Monthly Newsletter! 

Email:    

 

[ Click here for a printer-friendly PDF version of this issue. 750 KB ]

Legal Notes

The newsletter is free -- but does require a subscription. Please invite your friends 
to sign up at www.larryjordan.biz/newsletter.

To unsubscribe, simply send me an email and I'll remove you from the list. This list 
is not sold, rented, or bartered. The only person who knows you are on this list is 
me.

The information in this newsletter is believed to be accurate at the time of 
publication. However, due to the variety of possible system and software 
configurations, the author assumes no liability in case things go wrong. Please use 
your best judgment in applying these ideas.

The opinions expressed in this newsletter are solely those of the author. This 
newsletter has not been reviewed or sanctioned by Apple or any other third party. 
All trademarks are the property of their respective owners and are mentioned here 
for editorial purposes only.

Text copyright 2008 by Larry Jordan & Associates, Inc. All rights reserved. This 
newsletter may not be reproduced or published in any way, in whole or in part, 
without specific written permission from the author. 

Links to my home page or website articles are welcome and don't require prior 
permission. 

 

mailto:larry@larryjordan.biz?subject=Newsletter comments
http://www.larryjordan.biz/nxltrs/ljnxltr47.pdf
http://www.larryjordan.biz/nxlttrs.html


  
  
  
  
  
  
  
  
  
  

Home | About | Training | Articles | Goodies | Products | Email Support | Contact

© 2008, Larry Jordan & Associates, Inc. All rights reserved. info@larryjordan.biz

http://www.larryjordan.biz/index.html
http://www.larryjordan.biz/about/index.html
http://www.larryjordan.biz/training/index.html
http://www.larryjordan.biz/articles/index.html
http://www.larryjordan.biz/goodies/index.html
http://www.larryjordan.biz/store/index.html
https://www.larryjordan.biz/supportemail.html
http://www.larryjordan.biz/contact/index.html
mailto:info@larryjordan.biz

	larryjordan.biz
	Larry Jordan's Monthly Newsletter - #47 - Aug. 2008


	LKJKIIMHOFNFODKEBDNMNDGFDAFNGKPI: 
	form1: 
	x: 
	f1: Enter your email
	f2: 1011294719044
	f3: oi

	f4: Go
	f5: 

	form2: 
	x: 
	f1: 
	f2: 1011294719044
	f3: oi

	f4: Go
	f5: 




